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AutoCAD çalıştırıldığında AutoCAD penceresi açılır. Bu pencere istenilen tasarım  ve çizimlerin 
yapılacağı sonsuz bir alandır. Bu alanın etkin kullanımı için pencere üzerindeki elemanlardan en çok ihtiyaç 
duyulanları isimleri şöyledir:. 

 

 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

K O M U T L A R 
 

 
 

 

 
 
AutoCAD çizim programında çizgi komutunu kullanmanın çok çeşitli yöntemleri vardır. UCS koordinat 
sistemine bağlı kalmadan yapılacak bir çizimde pratik yöntem şöyledir: 
 
Komut çalıştırılır ve çizime başlanacak noktaya mouse ile tıklanır. Daha sonra çizgi ne tarafa doğru 
uzatılacaksa mouse tıklanmadan serbest biçimde o yöne yönlendirilir. Bundan sonra klavyeden mesafe girişi 
yazılarak enter tuşuna basılır. Burada önemli olan, çizimin düzgün olması için programın “polar” özelliğinin 
açık olmasıdır.  
 
Polar özelliği farklı şekillerde on (açık) duruma getirilebilir: 

Komut İsmi Line (Çizme) Komut İkonu 
İşlevi Düz Çizgi Çizimi 

 
Bulunduğu Menü Draw 
Komut Kısayolu L 
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1. Çizim ekranı altında “Mod Gösterici” düğmeler arasında bulunan polar  ikonu tıklanarak 
2. F10 tuşuna basarak 
 
Şayet UCS ikonu baz alınarak bir çizim oluşturulacaksa en azından başlangıçta çizime koordinat yöntemi ile 
başlamak gerekir. Koordinat yöntemi ile düz çizgi şöyle oluşturulur: 
 
Komut çalıştırılır ve başlangıç noktasına tıklanmadan klavyeden X ve Y başlangıç koordinat değerleri girilir ve 
enter yapıldığında imleç başlangıç noktasını yakalamış olur. Çizgimizin bir sonraki noktası, ya yukarıda 
anlatıldığı şekilde Mouse yardımıyla mesafe girilerek ve tıklanarak ya da yine klavyeden X ve Y koordinat 
değerleri girilerek belirlenir. Yani bu metotla, başlangıç noktası UCS ikonunun başlangıcıyla aynı olan 200 
birimlik bir doğru şu işlem sırasıyla çizilir: 
 
→Komut Çalıştırılır 
→(0,0) + Enter 
→ (100,0) + Enter + Enter  
 
(Burada klavyeden yazılan değerlerden ilk yazılanın X; ikinci yazılanın Y değeri olduğu ve aralarında mutlaka 
virgül bulunması gerektiği unutulmamalıdır.) 
 
NOT: UCS ikonuna göre çizimin önemli olduğu durumlarda da ikona bağlı olmadan yapılan çizimleri daha 
sonra ikona göre yerleştirebiliriz. Bu uygulamanın yapılış şekli ileride anlatılmaktadır. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 
 
 

Çizimi Ekrana Sığdırma 
 
 
1.  View → Zoom → Extents (Kısayolu: z + enter + e + enter) 
2. Mouse tekerleğine çift tıklama 
 
NOT: Mouse tekerleğine basılı tutmak suretiyle programın Pan   (kaydırma) özelliği kullanılır. Bu komut, 

Standart Araç Çubuğu’nda bulunan ikonu  tıklanarak, ya da komut satırına Pan (Kısayolu: P) yazılarak 
çalıştırılır.  
Tekerleği, çizimin ekrana sığdırılması için kullanmak gerektiğinde, çift tıklamanın seri biçimde yapılması 
gerekir. 
 

 
------------------------------------------------------------------------------------------------------------------------------------------------- 
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Nesne Yakalama Ayarları 
 
 
Nesne yakalama ayarları, Object Snap (Nesne Yakalama) araç çubuğu açılarak ve ekranda uygun bir yere 
yerleştirilerek, istenilen yakalama noktası buradan seçilerek kullanılabilir. Bu araç çubuğunun en çok 
kullanılan yakalama özellikleri şunlardır: 

 
Nesne yakalama ayarları, ayrıca, Mod Gösterici düğmelerden birisinin üzerine sağ tıklanarak, açılan 
seçeneklerden Settings seçeneği işaretlenerek yapılabilir. 
 

Settings …  → Object Snap  → Endpoint (Baş & Son Nokta) 
      → Midpoint (Orta Nokta) 
      → Center (Merkez) 
      → IntersecƟon (Kesişme) 
      → Extension (Uzatma) 
      → …………….. 

 
------------------------------------------------------------------------------------------------------------------------------------------------- 
 

 
 
 
 

 
 
Komut kullanılırken 2 seçenek mevcuttur: 
1. Önce komutun çalıştırılması:  

Komut İsmi Erase (Silme) Komut İkonu 
İşlevi Silme 

 
Bulunduğu Menü Modify 
Komut Kısayolu E 
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 Komut çalıştırıldıktan sonra silinecek nesneler seçilir ve enter tuşuna basılarak işlem tamamlanır. 
2. Önce nesnenin seçilmesi 
 Silinecek nesneler seçildikten sonra komut çalıştırılır ve böylece işlem tamamlanmış olur. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 
 
 

 
 
 
 
 
 
Komut kullanılırken 2 seçenek mevcuttur: 
1. Komut çalıştırılır ve kesişen doğrular Mouse ile seçildikten sonra enter tuşuna basılır. Daha sonra 
budanmak istenen uzantı kısımlarına Mouse ile tıklanarak işlem tamamlanır. 
2. Daha pratik kullanımda ise, komut çalıştırıldıktan sonra çizim ekranı üzerinde mouse sağ tıklanır. Sonra da 
budanacak kısımlar sol tıklanarak budama işlemi gerçekleştirilir. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 
 
 

 
 
 
 
 
 
Komut çalıştırılır ve çizim ekranı üzerinde mouse sağ tıklanır. Uzatılacak doğrunun uzamasını istediğimiz 
tarafına tıklanarak uzatma işlemi tamamlanmış olur. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 

 

 
Komut çalıştırılır ve kesişecek doğrular tıklanır. 

------------------------------------------------------------------------------------------------------------------------------------------------- 

Komut İsmi Trim (Budama) Komut İkonu 

İşlevi Kesişen 2 doğrunun fazlalıklarını 
budama işlevi görür 

 Bulunduğu Menü Modify 
Komut Kısayolu Tr 

Komut İsmi Extend (Uzatma) Komut İkonu 

İşlevi Herhangi bir doğruyu uzantısındaki 
nesneye kadar uzatma 

 Bulunduğu Menü Modify 
Komut Kısayolu Ex 

Komut İsmi Chamfer, Fillet Komut İkonu 

İşlevi 

1. İleride kesişecek 2 doğrunun 
uzatılarak birleşmelerini sağlar 
2. Köşe yuvarlama ve pahlama yapma 
işlevleri de vardır. 

 
 

 
Bulunduğu Menü Modify 
Komut Kısayolu Cha, F 
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Komut çalıştırılarak, kopyalanacak nesnelerin seçimi yapılır ve enter’a basılır. Sonra kopyalanacak nesne 
uygun bir yerine tıklanarak alınır ve sonraki yerine yine tıklanarak bırakılır. Bu komutla kopyalama yaparken 
komut bir kez çalıştırılsa bile birden fazla kopyalama yapılabilir. 
 
Copy komutu ile tıklamak suretiyle çoğaltmanın yanı sıra, mesafe girişi yapılarak ta çoğaltma yapılabilir. Bu 
amaçla kopyalanacak nesne seçildikten sonra enter yapılarak, belli uzaklığına kopyalanacak nesnenin ilgili 
kısmı tıklama yapılmadan yakalatılır. Mouse, ilgili yöne doğru yönlendirilerek extension yazısı görüldükten 
sonra, klavyeden mesafe girişi yazılarak enter tuşuna basılır ve uygulama tamamlanmış olur. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 
Offset komutu çalıştırılır. Klavyeden mesafe girişi rakam olarak yazılarak enter tuşuna basılır. Daha sonra 
çoğaltılacak nesne tıklanarak, çoğaltılmak istenen tarafta, çizim ekranında herhangi bir yere tıklanarak 
çoğaltma işlemi tamamlanmış olur. 
 
Aynı mesafeli paralel çoğaltmalarda komutu tekrar çalıştırmaya gerek kalmadan önce obje seçimi, sonra 
ekrana tıklama şeklinde istediğimiz kadar offset yapmak mümkündür.  
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 
Move komutu çalıştırılır. Taşınacak obje seçilir. Sonra objenin herhangi bir referans noktasına tıklanarak 
istediğimiz yere götürüp, tıklama suretiyle bırakılır. Burada bilinmesi gereken,referans noktasının, taşınacak 
objenin üzerinde bulunma zorunluluğu yoktur. Çizim ekranı üzerinde her hangi bir nokta olabilir. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

Komut İsmi Copy (Kopyalama) Komut İkonu 

İşlevi Nesnenin kopyalama yöntemiyle 
çoğaltılmasını sağlar. 

 

 
 

Bulunduğu Menü Modify 
Komut Kısayolu Co 

Komut İsmi Offset (Paralel Kopyalama) Komut İkonu 

İşlevi Çizginin belli paralelde 
çoğaltılmasını sağlar 

 

 
 

Bulunduğu Menü Modify 
Komut Kısayolu O 

Komut İsmi Move (Taşıma) Komut İkonu 
İşlevi Çizginin ya da objenin taşınması  

 
 

Bulunduğu Menü Modify 

Komut Kısayolu M 
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Rotate komutu çalıştırılır. Döndürülecek obje seçilir ve enter’a basılır. Sonra, cisim hangi noktadan 
döndürülecekse, o nokta tıklanmak suretiyle belirlenir. Daha sonra Mouse yardımıyla ve ya açı girmek 
suretiyle döndürme işlemi gerçekleştirilir. 
 
Açı vermek suretiyle döndürmede, cismin döndürülme noktası belirlendikten sonra, klavyeden açı yazılarak ve 
sonra da enter tuşuna basılarak döndürme işlemi tamamlanmış olur. Burada, ( ) saat yönündeki 
döndürmede açının eksi (-) alınması gerektiği unutulmamalıdır.  
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 

 
Join komutu çalıştırılır. Birleşerek bir bütün olması istenen aynı eksendeki 2 doğru sırasıyla tıklanır. Daha 
sonra enter yapılarak uygulama tamamlanmış olur. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 

 
Komut çalıştırılarak ölçeği değiştirilecek objelerin seçimi yapılır ve enter’a basılır. Sonra, büyütmenin referans 
olarak gerçekleştirileceği nokta tıklanarak belirlenir. Sonra klavyeden değiştirilme oranı yazılarak enter yapılır 
ve işlem tamamlanmış olur.  
 
Burada önemli olan husus, eğer obje büyütülmek isteniyorsa, değiştirme ölçeği 1’den büyük bir rakam; obje 
küçültülmek isteniyorsa, değiştirme ölçeği 0-1 arası bir rakam seçilmelidir. 

------------------------------------------------------------------------------------------------------------------------------------------------- 

Komut İsmi Rotate (Döndürme) Komut İkonu 
İşlevi Çizginin ya da objenin döndürülmesi  

 
 

Bulunduğu Menü Modify 

Komut Kısayolu Ro 

Komut İsmi Join (Katılmak, Bütünlemek) Komut İkonu 

İşlevi Aynı eksendeki 2 çizginin 
birleştirilmesi 

 

 
 

Bulunduğu Menü Modify 
Komut Kısayolu J 

Komut İsmi Scale (Oransal büyütme & küçültme) Komut İkonu 

İşlevi Nesnelerin belli oranda büyütülüp 
küçültülmesi 

 

 
 

Bulunduğu Menü Modify 
Komut Kısayolu Sc 
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Komut çalıştırılarak enter tuşuna basılır. Daha sonra aynalama ekseninin önce 1. Sonra da 2. Noktası 
tıklanarak seçilir. Bu seçimden sonra “Erase source objects?” (Kaynak obje silinsin?) sorusu karşımıza çıkar. 
Burada N (No: Hayır) seçeneği seçilmiş durumdadır. Bu aşamada enter yapılırsa aynalanan obje kalır. Ancak 
bu sorudan sonra Y (Yes: Evet) harfi seçilirse, orijinal obje silinir ve aynalanan obje çizim ekranında kalır. 
 
Mirror Komutu ile ilgili şu hususun bilinmesi gerekir: 
Bu komut, yazılı bir metinle birlikte kullanıldığında, buradaki yazının aynalanıp aynalanmayacağının 
ayarlaması yapılabilir. Komut satırına MIRRTEXT (mirrtext) yazarak enter yaptığımızda karşımıza 0 (sıfır) ya 
da 1 değişkenlerinden birisi çıkar.  
Bu değişkenin 0 (sıfır) olması, aynalamada yazının aynalanmadan kalmasını; 1 olması ise, yazınında aynen 
obje gibi aynalanmasını sağlar. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 

 
Komut çalıştırılarak patlatılacak obje seçilir ve enter yapılır. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

Komut çalıştırıldığında, öncelikle çizimi yapılacak daire merkezini işaretlememiz istenir. Merkez 
işaretlendikten sonra radius (yarıçap) yada diameter (çap) seçeneklerinden birisi ile, ölçü girilerek daire çizimi 
yapılır. 
Daire çizimi için komut çalıştırıldıktan sonra, bu daireyi 3p (3 noktasını girerek), 2p (2 noktasını girerek) ve ya 
tan, tan, radius (teğet, teğet, yarıçap) seçeneklerinden birisi ile de çizmek mümkündür. Bu seçeneklerden; 
 

Komut İsmi Mirror (Aynalama) Komut İkonu 

İşlevi Nesnelerin bir eksene 
göre aynalanması 

 Bulunduğu Menü Modify 
Komut Kısayolu Mi 

Komut İsmi Explode (Dağıtma, Patlatma) Komut İkonu 

İşlevi Parçalardan meydana gelen bütün 
objenin parçalarına ayrılması 

 Bulunduğu Menü Modify 
Komut Kısayolu X 

Komut İsmi Circle Komut İkonu 
İşlevi Daire çizimi 

 
Bulunduğu Menü Line 
Komut Kısayolu C 
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3p   : 3 nokta tıklanarak, bu 3 noktadan geçen daireyi oluşturur. 
2p   : 3 nokta tıklanarak, bu 2 noktadan geçen daireyi oluşturur ki bu 2 nokta dairenin 
çapıdır. 
Tan, tan, radius : 2dairenin teğet olarak yerleşmesini istediğimiz 2 doğru işaretlenir ve sonra da bu 
daireye radius (yarıçap) değeri girilerek çizim tamamlanmış olur. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 

Komut çalıştırılır ve 2 nokta tıklanarak sonsuz çizgi meydana getirilmiş olur. Komutun uygulanması esnasında, 
sonsuz çizginin yatay/düşey oluşturulmasında zorlanılıyorsa, seçeneklerden, yatay çizgi için H (Horizontal: 
Yatay), düşey çizgi için ise V (Vertical: Düşey) seçimleri yapılır. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 
Komut çalıştırıldığında, öncelikle çokgen köşe sayısını girmemiz istenir. Daha sonra, çokgenin merkezini mi 
yoksa kenar uzunluğunu mu gireceğimiz sorulur.  
 
Burada, otomatik seçilmiş tercih çokgen merkezini gireceğimiz seçimdir. Bundan sonra karşımıza çıkan 2 
seçenekten “Inscribed in circle” seçeneği, çokgeni, yarıçapını verdiğimiz dairenin içine; “Circumscribed about 
circle” seçeneği ise çokgeni, yarıçapını verdiğimiz dairenin dışına oluşturur. 
 
Çokgenin kenar uzunluğunu girmek suretiyle çizilmesinde ise edge (kenar) seçeneği tercih edilir. Bu tercihten 
sonra, önce çokgeni meydana getirecek kenarlardan birisinin 1. noktası, sonra, aynı kenarın 2. Noktası 
işaretlenerek çokgen çizimi tamamlanır. 2. Noktanın işaretlenmesinde line (çizgi) komutunun kullanımında 
olduğu gibi, klavyeden mesafe girişi yapılarak ta kenar uzunluğu ölçülü olarak belirlenebilir. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

  

Komut İsmi Construction Line  Komut İkonu 
İşlevi Sonsuz Çizgi Çizme 

 
Bulunduğu Menü Line 
Komut Kısayolu Xl 

Komut İsmi Polygon (Çokgen) Komut İkonu 
İşlevi Çokgen Çizimi 

 
Bulunduğu Menü Line 
Komut Kısayolu Pol 
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Komut çalıştırıldığında öncelikle Rectangular (Dikdörtgensel) ya da Polar (Dairesel) çoğaltmadan birisi seçilir. 
 
Rectangular (Dikdörtgensel) Çoğaltma: 
 

 
 
Çoğaltılacak nesne kaç sıra (Rows) ve kaç sütun (Columns) olacaksa rakamsal olarak girilir. Daha sonra, 
sıraların ve sütunların offset mesafeleri rakamsal olarak girilir ve Select objects tıklanarak çoğaltılacak 
nesnenin seçimi yapılır.  
 
Çoğaltmanın nasıl görüneceği, istenirse Preview seçeneği ile ön izlenebilir. OK seçeneği ile dikdörtgensel 
çoğaltma tamamlanmış olur. 
 
Burada, sıra ve sütunların çoğaltılacağı yönlerin değiştirilmesi gerektiğinde offset değerlerinin başına (-)(eksi) 
işaretinin konması gerektiği unutulmamalıdır.  
 
Polar (Dairesel) Çoğaltma: 
 

 
 
 

Komut İsmi Array (Dizi halinde çoğaltmak) Komut İkonu 

İşlevi Nesnelerin doğrusal ya da 
dairesel çoğaltılması 

 Bulunduğu Menü Line 
Komut Kısayolu Ar 
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Daire etrafında döndürülerek çoğaltılacak nesnenin Merkez noktası (Center point) X – Y değerleri girilerek ya 
da ikon tıklanarak seçilir. Daha sonra; 
Total number of items (çoğaltılacak öğenin toplam sayısı), 
Angle to fill (çoğaltmada döndürme açısı), 
Angle between items (öğeler arasındaki açı) seçeneklerinden 2 tanesi seçilir. Daha sonra Select object (Obje 
seçimi) seçeneğinden, çoğaltılacak objeler seçilerek, istenirse Preview ile ön izleme yapılır ve OK seçeneği ile 
işlem tamamlanmış olur. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 
Doğruların Belli Sayıya ya da Belli Aralıklara bölünmesi 

 
 
Doğruların Belli Sayıya Bölünmesi: 
 
(Uzunluğu ne olursa olsun, bir doğruyu belli sayıda parçalara böldüğümüzde, ortaya çıkan parçaların 
tamamının boyları birbirlerine eşit olur.) 

Bir doğruyu eşit mesafelere bölmek için Divide (Bölmek) komutu kullanılır. (İkonu:  ) Bu komuta şöyle 
ulaşılır: 
 
Draw  → Point → Divide 
 
Komut çalıştırıldığında bölünecek nesnenin seçilmesi istenir. Nesne seçimi yapıldıktan sonra da, nesnenin kaç 
eşit parçaya bölüneceği sorulur. Bu değer verildikten sonra enter yapılarak işlem tamamlanmış olur. 
 
Önemli Not: Bölme işlemi tamamlandıktan sonra, nesneyi parçalarına ayıran noktaları göremiyorsak, geçerli 
nokta işaret formatını değiştirmemiz gerekir. Nokta işaret formatı şöyle değiştirilir: 
 
Format  →  Point Style … 
 
Doğruların Belli Aralıklara Bölünmesi: 
 
(Bir doğruyu belli aralıklarla parçalara ayırdığımızda, duruma göre işlem sonunda doğrunun boyunda bir 
miktar artan parça kalabilir. Örneğin; 12 birim uzunluğunda bir doğruyu 4 er birim aralıklarla bölerken ortaya 
birbirine eşit 3 parça çıkarken, aynı doğruyu 5 er birim aralıklarla böldüğümüzde 2 adet aynı parça çıkarken  2 
birimlik kısım ise fazlalık olarak kalır.) 

Bir doğruyu belli aralıklara bölmek için Measure (Ölçü) komutu kullanılır.(İkonu:  ) Bu komuta şöyle 
ulaşılır: 
 
Draw  → Point → Measure 
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Komut çalıştırıldığında belli uzunluklara bölünecek nesnenin seçilmesi istenir. Nesne seçimi yapıldıktan sonra 
da, ne kadarlık uzunluklarla bölüneceği sorulur. Bu değer verildikten sonra enter yapılarak işlem 
tamamlanmış olur. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 
AutoCAD’ te Yazı Yazmak 

 
 
Genel menü dosyasından Text menüsü aktif hale getirilir.  
 

  
 

Buradan Multiline Text …  (çok hatlı yazı) ya da Single Line Text  (tek hatlı yazı) seçeneklerinden birisi 
tıklanarak yazı aktifleştirilmiş olur. Çizim ekranında yazı alanı ya da boyutu belirlenerek istenilen yazı yazılır.  
 
Önemli Not: Farklı fontta yazı atanması için Text Style kısmından yeni fontların belirlenmesi gerekir. Ayrıca 
yazılmış yazının bazı özellikleri (örneğin büyüklüğü gibi), properties (özellikler) seçeneğinden düzenlenebilir. 
Properties, düzenleme yapılacak yazıya sağ tıklandığında karşımıza çıkan menüden açılabilir. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 
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AutoCAD’ te Tarama Yapmak 

 
 
 
 
 
 
 
Hatch (tarama)  komutu çalıştırıldığında aşağıdaki tarama ekranı açılır. 
 

 
 
Buradan öncelikle Pattern (desen) kısmında bulunan üç nokta (…) tıklanarak, tarama deseni seçilir. Sonra 
Add: Pick points (Ekle: Nokta seçin) tıklanarak, taranacak alanların içi, tıklanarak seçilir. Seçimden sonra 
enter yapıldığında tarama ekranı tekrar karşımıza çıkar. Burada varsa son düzeltmeler yapıldıktan sonra OK 
tıklanarak tarama tamamlanmış olur.  
 
İstenirse, tarama tamamlanmadan Preview (ön izleme) seçeneği ile, tamamlanan taramanın nasıl görüneceği 
izlenebilir. 
 
Önemli Not: Tarama yapılacak alanın kenarlarında hiçbir boşluk bulunmamalıdır. Eğer tarama alanı tam 
kapatılmamışsa tarama hata verecektir. Çizimin genel özellik olarak kapanmaması gerekiyorsa, tarama Add: 
Select object (Ekle: Nesne seç) seçeneği ile, taranacak alanı çevreleyen çizgiler teker teker seçilerek 
gerçekleştirilir. 

Komut İsmi Hatch (Tarama) Komut İkonu 
İşlevi Tarama yapma 

 
Bulunduğu Menü Line 
Komut Kısayolu H 
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İç içe çizilmiş şekillerin taranmasında, istediğimiz bölgelerin taranmasında sorun çıkıyor ise, tarama ekranında 

bulunan  butonu ile farklı tarama özelliklerini belirleyeceğimiz bölüm açılır. Buradaki Island display style 
(Bölge görüntüleme stili) ile taranmasını istediğimiz bölgelerin seçimi yapılır. 
 

Normal (Normal) : Bir alan tarama, bir alan boşluk olacak şekilde tarar 
Outher (Dış)    : Sadece seçili alanı tarar 
Ignore (Göz ardı) : Seçilen ilk alanı sınırlayan bölgenin içini tamamen tarar. 
 

Önemli Not: Tarama bittikten sonra, tarama özelliklerinde değişiklik yapmak istersek, (örneğin, tarama 
rengini ya da sıklığını değiştirmek gibi) taramaya sağ tıklayarak properties (özellikler) kısmından bu 
değişiklikleri gerçekleştirebiliriz. 
 
NOT: AutoCAD için hazırlanmış “pat” uzantılı dosyaları program içine atarak tarama kütüphanesinin 
zenginleştirilmesi mümkündür. Tarama dosyaları programa şöyle dahil edilir: 
 
Programın kurulu olduğu bölümdeki  Program Files klasörü içindeki AutuCAD klasörü açılır. Buradaki Support 
klasörünün içerisine pat uzantılı dosyalar kopyalanır.  
 
Bu dosyalara, tarama çeşitlerine ulaştığımız tarama paletinin (Hatch Pattern Palette) Custom kısmından 
ulaşarak kullanabiliriz. 
 
 

 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 
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Bazı eğrisel çizgi çizme komutları 

1. 

 

 

 
 
Komut çalıştırılarak değişim noktalarına mümkün olduğunca sık bir şekilde tıklama yapılır ve son noktadan 
sonra enter yapılarak çizim tamamlanır. 
 
2. 
Sketch (Serbest Elle Kroki, taslak çizimi) 
 
Komut satırına sketch komutu yazılarak enter tuşuna basılır böylece komut çalıştırılmış olur. Bu aşamada 
Type (Tip) seçeneği ile çizilecek çizginin tipi seçilir. Bu tip Lines (çizgi), Polyline (Sürekli çizgi) ya da Spline 
(Köşeleri yumuşak bir şekilde yuvarlatılmış çizgi) seçeneklerinden birisi olabilir. Bu seçimden sonra tıklama 
yapılmadan, imleç çizim ekranı üzerinde gezdirilerek çizim yapılır. 
 
Komut çalıştırıldığında karşımıza çıkan seçeneklerden Increment (Artış) seçeneği tercih edilirse, serbest 
çizginin kırıklıklarının boyu, ekrana yaptığımız ilk 2 tıklama aralığı kadar seçilmiş olur. 
 
Komut çalıştırıldığında karşımıza çıkan seçeneklerden Tolerance (Tolerans) seçeneği seçilirse, yapılacak 
çizimin kırıklıklarının uzunluğu bu satıra yazılarak verilmiş olur. 
 
3. 
Arc (Yay Çizimi) 
 
Yay çizimine şu yolla ulaşılabilir. Burada yay çizmenin değişik seçenekleri verilmiştir: 
 
Draw  → Arc → 3 Points   (3 Nokta) 
    Start, Center, And  (Başlangıç, Merkez, Son) 
    Start, Center, Angle (Başlangıç, Merkez, Açı) 
    Start, Center, Length (Başlangıç, Merkez, Uzunluk) 
    Start, And, Angle  (Başlangıç, Son, Açı) 

Start, And, Direction (Başlangıç, Son, Yön) 
Start, And, Radius  (Başlangıç, Son, Yarıçap) 
Center, Start, And  (Merkez, Başlangıç, Son) 
Center, Start, Angle (Merkez, Başlangıç, Açı) 
Center, Start, Length (Merkez, Başlangıç, Uzunluk) 
Continue   (Devamlı) 

 
Bu farklı yay çizim tekniklerinden, çok kullanılanlardan birisi  Start, And, Direction (Başlangıç, Son, Yön) 
komutudur.  
 

Komut İsmi Spline (Eğrisel çizgi) Komut İkonu 
İşlevi Sürekli Eğrisel Çizgi Çizme 

 
Bulunduğu Menü Line 
Komut Kısayolu Spl 
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Komut çalıştırıldığında önce yayın başlangıç noktası, sonra da bitiş noktası seçilir. Daha sonra da Mouse 
hareket ettirilerek yayın uygun pozisyonu bulunur ve tıklama yapılarak yay çizimi tamamlanmış olur. 
 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 
Nesne Hizalama 

 

Align (Hizalama)  

Önce komut çalıştırılır ve hizalanacak nesnenin seçimi yapılır. Enter tuşuna basıldıktan sonra sırasıyla, 
hizalanacak nesnenin 1. Noktası sabit nesnenin 1. Noktasına, hizalanacak nesnenin 2. Noktası da sabit nesnenin 
2. Noktasına tıklanarak enter yapılır.  

Bu esnada “Scale object based on alignment points?” (Nesnenin hizalamada ölçeği değiştirilsin mi?) sorusuna Y 
(Yes: Evet) ya da N (No: Hayır) seçeneklerinden birisi seçilerek cevap verilir.  

Bu aşamada hiçbir seçim yapılmadan enter yapılırsa N (No: Hayır) seçeneği seçilmiş olduğundan hizalama yapılır 
ancak ölçek değiştirilmez. 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 
Katman (Layer) Atamak 

 
 
 
 
 
 
 
Komut çalıştırıldığında ekrana aşağıdaki Layer Properties Manager (Katman Özellikleri Yöneticisi) penceresi 
gelir: 

 

Komut İsmi Layer Komut İkonu 

İşlevi Çizimin farklı bölümlerini farklı 
katmanlara atamada kullanılır 

 Bulunduğu Menü Layers 
Komut Kısayolu La 
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Bu pencere üzerinde New Layer  tıklandığında, yeni katman “Layer1” ismi ile oluşturulmuş olur. Bu isim 
istenirse değiştirilebilir. Atanmış olan bu katmanın; rengi, “Color” kısmından; çizgi tipi “Linetype” kısmından; 
çizgi kalınlığı ise “Lineweight” bölümlerinden ayarlanabilir. Daha sonra bu pencere kapatılır. 

Ataması yapılmış olan katmanlar, çizim ekranındaki Layer Control (Katman Kontrol) panelinden izlenebilir.  

 

İstenirse de bu panelde, ilgili kaymanın yanındaki  ikonu tıklanmak suretiyle kapatılabilir. 

AutoCAD ile çizim yapılırken,  Layer Control (Katman Kontrol) panelinde aktif olan (açık bulunan) katman 
kullanılır. Eğer yapılmış olan bir çizimin katmanı değiştirilmek istenirse, önce katmanı değiştirilecek objeler 
seçilir. Sonra atanmak istenen katman tıklanır. Ve son olarak ta esc tuşuna basılarak işlem tamamlanmış olur.  

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

Blok Yapmak 
 
 
 
 
 
 
 
 
Komut çalıştırıldığında ekrana aşağıdaki seçenek penceresi gelir: 

 

 

Burada öncelikle oluşturulacak blok’a isim verilmesi gerekir. İsim, Name (isim) kısmına yazılır. 

Komut İsmi Make Block (Blok yapmak) Komut İkonu 

İşlevi Parçalar halinde yapılmış çizimi 
bir bütün haline bloklar 

 Bulunduğu Menü Line 
Komut Kısayolu Block 
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Daha sonra Select object (Obje seç) işaretlenerek, bloklanacak objeler seçilir ve enter yapılır. Böylece 
bloklama tamamlanmış olur. 

Çir çizim ekranında çok sayıda bloklama yapmak mümkündür. Bloklanmış olan çalışmaları tekrar çizim üzerine 

almak için Insert Block  (Kısayolu: I) komutundan faydalanılır. 

 ------------------------------------------------------------------------------------------------------------------------------------------------ 

Parça Çizgileri Sürekli Hale Getirmek 

 

 

 

 

Komut çalıştırıldığında bütün haline getirilmek istenen çizgilerden birisi tıklandığında “Do you want to turn it 
into one? <Y>” seçeneği karşımıza çıkar. Bu bölüm enter ile geçildiğinde, karşımıza çıkan seçeneklerden Join 
(Katmak) seçeneği seçilir. Daha sonra birleştirilmek istenen çizgi parçalarının tamamı seçilir ve enter yapılır. 
Daha sonra birkez daha enter yapılarak çizgiler bütünleştirilmiş olur. 

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 

 

Komut çalıştırıldığında aşağıdaki pencere ekrana gelir: 

 

 

Komut İsmi Edit Polyline  (Çoklu Çizgi Düzenleme) Komut İkonu 

İşlevi Parçalar halinde yapılmış çizgileri bir 
bütün haline çevirir 

 Bulunduğu Menü Modify II 
Komut Kısayolu Pe 

Komut İsmi Boundary  (Sınırları Polyline yapma) Komut İkonu 

İşlevi Parçalar halinde kapalı şekilleri bir 
bütün haline çevirir 

 Bulunduğu Menü Draw 
Komut Kısayolu Bo & _bo 
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Burada Pick Points (Nokta seçme) kısmı tıklandığında kutucuk kapanır ve imleç şekli değişir. Bu aşamada 
boundary yapılacak kapalı şeklin ortasında bir nokta tıklanır. Daha sonra enter yapılarak işlem tamamlanır. 

Bu komutun kullanımında şu hususa dikkat etmemiz gerekir: Bu şekilde boundary yapıldığında, alt tarafta 
mevcut bulunan parçalı çizgiler aynen kalmakla beraber, geçerli katman kullanılarak bunun üzerinde yeni bir 
polyline hat oluşturulmuş olur. Yani, var olan bir çizginin üzerine bir kez daha çizgi oluşturulduğundan üst üste 
iki çizgi meydana gelmiş olur. Bu komut kullanıldığında altta kalmış olan eski çizgilerin silinmesi 
unutulmamalıdır.   

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

Çizimin ya da UCS (User Coordinate System) Kullanıcı Koordinat Sistemi’nin konumunun değiştirilmesi 

 

AutoCAD çizimlerinde çizimin ekrandaki pozisyonunu UCS ikonuna göre yeniden belirlemek gerekebilir. Bunu 
iki farklı şekilde yapmak mümkündür: 

1. Çizimi sabit tutup, UCS ikonunu çizimin istediğimiz yerine taşımak 

 

 

UCS araç çubuğundaki  ucs ikonu  tıklanarak komut çalıştırılmış olur. Daha sonra, mevcut çizimin her 
hangi bir yerini tıkladığımızda  ikon buraya taşınmış olur. 

 

2. UCS ikonunu sabit tutup, çizimi ikona göre taşımak 

Bunu, bilinen UCS koordinatlarına göre kullanabilmek için öncelikle Absolite coordinates (Tam koordinatlar) 
seçeneğinin işaretli olması gerekir. Bu seçeneğin ayarlarına şöyle ulaşılır: 

Mod göstericilerin üzerine sağ tıklanarak Settings… (Ayarlar) penceresi açılır. 
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Açılan pencereden Dynamic Input bölümü tıklanır. 

 

Buradan, Pointer Input bölümündeki Settings… bölümüne girilir. 

 

Bu bölümdeki Format kısmından Absolute coordinates kısmı işaretlenerek, çizimi taşıma işlemine 
başlanabilir.  
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KISA YOL:  Dynamic Input bölümünü tıkladığımızda karşımıza çıkan Drafting Settings penceresindeki 
Enable Pointer Input kutucuğunda bulunan işaret kaldırılırsa, taşıma kotlarının UCS ikonuna göre 
kabul edilmesi kısa yoldan ayarlanmış olur. 

Bu genel ayarlardan sonra, öncelikle Move (Taşıma) komutu çalıştırılarak, taşınacak objelerin seçimi 
yapılır ve enter ile sonraki aşamaya geçilir. Bu aşamada taşınacak objenin referans noktası seçilir ve 
tekrar enter yapılır. Son aşamada ise X ve Y koordinatları yazılarak enter yapıldığında çizimin 
istediğimiz noktası UCS ikonuna göre konumlandırılmış olur.  

ÇOK ÖNEMLİ NOT: UCS ikonunun X ve Y koordinat doğrularının kesişim noktasının X ve Y koordinat 
değerleri 0,0 (sıfır, sıfır)’dır. Bu yüzden, taşınacak objenin referans noktasının koordinatları 0, 0 
olarak girilmelidir.  

------------------------------------------------------------------------------------------------------------------------------------------------- 

 

Auto Cad programı için karşılaşılabilecek bazı sorunlar ve çözüm yolları 

 

SORUN: Ölçülendirme yapılmış çizimde taşıma ya da döndürme yapıldıktan sonra çizimde ya da ölçülerde 
deformasyon meydana gelmesi. 

ÇÖZÜM: Tamamlanmış çizimde dda + Enter yapılır ve tüm çizim seçilir. Daha sonra tekrar Enter yapılır. 

Eğer ölçülendirmeleri olan bir çizim yapılacağı belli ise, çizime başlanmadan önce komut satırına 
DIMASSOC (Dimassoc) yazılarak enter yapılır. Burada 2 olarak tanımlanmış değer 1 olarak değiştirildiğinde 
çizimin taşınması ya da döndürülmesi durumunda ölçülerde kayma meydana gelmez. 

Ya da, komut satırına DIMDISASOCIATE (dimdisassociate) yazılarak enter yapılır. Sonra ölçüler 
seçilerek tekrar enter yapıldığında sorun çözülmüş olur. 

*** 

 

SORUN: Auto Cad ekranındaki koordinat simgesinin kaldırılması 

ÇÖZÜM: Komut satırına UCSICON (ucsicon) yazılıp enter yapılır. Seçeneklerden OFF (Kapalı) seçeneği seçilerek 
enter yapılır. İkonun tekrar görünmesi istendiğinde komut satırına aynı komut yazılarak bu kez ON (Açık) 
seçeneği tercih edilir. İkonun ekranda, ancak sabit kalması istenirse komut çalıştırıldıktan sonra karşımıza 
gelen seçeneklerden Noorigin seçeneği seçilmelidir. 

*** 
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SORUN: Kaydetmelerde BAK dosyasının oluşması. 

ÇÖZÜM: ISAVEBAK sistem değişkeni ile BAK dosyasının oluşup oluşmamasını kontrol Etmek mümkündür. 
Komut satırına ISAVEBAK (isavebak) yazarak bu değişkene atanmış değişken değerini değiştirebiliriz. Bu 
değişkenin,  
0 değeri BAK dosyasının oluşması istenmediğinde,  
1 değeri BAK dosyasının oluşması istendiğinde kullanılır. 

*** 

SORUN: Çember, yay gibi eğrisel çizgilerin görüntü çözünürlüğünün düzenlenmesi. 

ÇÖZÜM: Komut satırına VIEWRES (viewres) yazılarak enter tuşuna basılır. Karşımıza çıkan değer 1-20000 
arasında değiştirilebilir. Bu değerin yüksek olması görüntü çözünürlüğünü yükseltir. 

*** 

SORUN: Open (Aç), Save (Kaydet) gibi komutlarda pencere yerine komut satırının aktif olması (Yani 
Pencere gelmemesi) 

ÇÖZÜM: Komut satırına FILEDIA (filedia) yazılarak enter tuşuna basılır. Karşımıza çıkan değer 1 olarak 
değiştirilir. 

*** 

SORUN: Çizim çalışma ekranının rengini değiştirme. 

ÇÖZÜM:  

Tools → Options → Display → Colors penceresi açılır ve Color (renk) kısmından istenilen renk seçilir. 

*** 

SORUN: AutoCad kurulduğunda karşımıza çıkan değiştirilmiş arayüzün klasik görünüme çevrilmesi. 

ÇÖZÜM:  

Tools → Workspaces → AutoCad Classic seçimi yapılarak görünüm klasik görünüme değiştirilebilir. Ayrıca, 
ekranın sağ alt tarafında bulunan   (Workspace Switching) ikonu tıklanarak ta açılan pencereden AutoCad 
Classic seçeneğiyle görünüm değiştirilebilir. 

*** 

SORUN: Seçim yaparken sacede 1 obje seçilmesi, 2. Obje seçildiğinde ilk seçilen objenin seçiminin kalkması. 

ÇÖZÜM: 

Tools → Options → Selection →”Use ShiŌ to add to selecƟon” kutucuğunun işareti kaldırılır. 

*** 
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SORUN: Araç çubuklarının ekranda görünmemesi. (Kaybolması) 

Çözüm: 

Ctrl + 0 (Sıfır) tuşlarına birlikte basılarak araç çubuklarının görünmesi ya da görünmemesi sağlanabilir. 

*** 

SORUN: Command (Komut) satırının ekranda görünmemesi. (Kaybolması) 

Çözüm: 

Ctrl + 9 (Dokuz) tuşlarına birlikte basılarak komut satırının görünmesi ya da görünmemesi sağlanabilir. 

*** 

SORUN: Çizim ekranında menülerin (Menü çubuğunun) kaybolması. 

ÇÖZÜM: Komut satırına “ribbon” (RIBBON) yazılır ve enter yapılır. 

 

 

  


